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Migrating from FormReader 6.5 to FlexiCapture 9.0

About this Document

This document describes how to migrate from FormReader 6.5 to FlexiCapture 9.0. FlexiCapture 9.0 represents the new generation of 
ABBYY data capture solutions with improved technologies and robust architecture. Templates created in FormReader 6.5 can be used in 
FlexiCapture 9.0 (refer to details below), but installation and configuration of 9.0 is different from 6.5 (detailed installation instructions are in 

the Administrators Guide available from the installation DVD).

New Product Names

Version 6.5 Version 8.0 Version 9.0

FormReader 6.5 Desktop Edition FlexiCapture 8.0 Professional FlexiCapture 9.0 (Standalone Installation)

FormReader 6.5 Enterprise Edition - FlexiCapture 9.0 (Distributed Installation)

FlexiCapture Studio 1.5 FlexiLayout Studio 8.0 FlexiLayout Studio 9.0

FormDesigner 2.5 FormDesigner 8.0 FormDesigner 9.0

 
Installation

Old and new versions of the FormReader/FlexiCapture products have completely separate installation processes, which means that configuration 
of the old version will not be inherited by the new installation. Old and new versions are treated as separate products. FormReader 6.5 and 
FlexiCapture 9.0 can be installed on the same machine. The installation instructions for FlexiCapture 9.0 can be found in the Administrator’s 
Guide on the disk with FlexiCapture 9.0. You can open it using the Autorun menu.

Licenses

A new FlexiCapture 9.0 license is required in order to use FlexiCapture 9.0. The license used for FormReader 6.5 will not work with 
FlexiCapture 9.0. It is possible to write a FlexiCapture 9.0 license into the same hardware key where the FormReader 6.5 license is stored. 
The license can be written into the key using the License Manager utility shipped with FlexiCapture 9.0.

Software and Hardware requirements
Please refer to the “Software and hardware requirements” article in the Help File to check if your hardware and software configuration meets 
FlexiCapture 9.0 system requirements. Please note that it is strongly recommended to use server operating systems for the server installation. 
You can use other operating systems to install servers for demonstration purposes only, but since those operating systems have a limited number 
of connections, running in a production environment is not recommended. Installation of the Application Server requires additional software to 
be installed prior to server install using Internet Information Server 6 or 7 and .NetFramework 2.0 or later.

For more details please refer to the Administrator’s Guide on the disk with FlexiCapture 9.0. You can open it using the Autorun menu.
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System Configuration

Servers and Stations
FlexiCapture 9.0 Standalone comes with the Administrator station only, which can be used to create and fine-tune projects (including 
Document Definition Creation) and for document processing.

FlexiCapture 9.0 Distributed has the following servers and stations:

 
FormReader 6.5 Enterprise Edition FlexiCapture 9.0 Distributed

-

Application Server (required)

Ensures correct operation of the entire system. The stations communicate among 
themselves via the Application Server.

Protection Service
Protection Server (required)

License Manager is used to manage licenses

Database 

MSDE (SQL 2000)

Database Server (required)

SQL 2005, SQL 2008 or SQL Express can be used. SQL Express is supplied with  
FlexiCapture 9.0.

File Storage on the Application Server can be used to store project files. If you don’t 
use it, all files will be stored in the Database.

-

Processing Server (required)
Distributes the workload among the  
Processing Stations.

Protection Server Monitor is used for monitoring the Processing Server’s work.

Recognition Station

Recognition only

Processing Station (required)

Performs the following operations: recognition, import from HotFolder, export.

Administrator Station

Project Setup Station (required)

This station is used to create and set up projects. User’s rights management was 
moved to the Administrator and Monitoring Console.

Export and Monitoring Station

Administration and Monitoring Console (required)
Monitoring of the whole system’s work, reports generation, users’ rights management, 
database creation. 

The Administration and Monitoring Console is installed with the Application Server. 
You can also access it from another computer (if the user has proper rights). To open 
it, type the following address in your browser: http://<AppServer>/flexicapture/Home.
aspx, where <AppServer> is the name of your Application Server.

Export is executed by Processing Stations.

Export Confirmation is available on the Verification Station if the corresponding queue 
is turned on.

Correction Station Verification Station (optional)

Verification Station Data Verification Station (optional)
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FormReader 6.5 Enterprise Edition FlexiCapture 9.0 Distributed

Scanning Station Scanning Station (optional)

Registration Station

Registration Station was incorporated into any FlexiCapture 9.0 license by default.

Now, import from HotFolder is set up on the Project Setup Station and performed by 
Processing Stations.

It is also possible to import from HotFolder to the Scanning Station (using a virtual 
scanner).

Number of Servers and Stations
One FlexiCapture installation should have one server of every type. The number of stations depends on your needs and is controlled by the 
license.

For example, the number of Project Setup, Verification, Data Verification and Scanning stations that can be running simultaneously is 
controlled by the license parameter and can be checked through the License Manager Utility.

All the stations above have their analogs in FormReader 6.5 Enterprise Editions.  You may need the same number of stations you used in 
6.5. You can also use the Configuration Calculator to calculate the preliminary number of stations.

The number of Processing Stations is not limited since productivity is controlled either by the number of pages or by the number of cores. 
The Administration and Monitoring Console has no limitations on the number of running copies and, you can use this station from any 
computer.

Database 
FlexiCapture 9.0 supports SQL 2005 or SQL 2008. Existing databases used in FormReader 6.5 Enterprise Edition (that are based on MSDE 
or SQL 2000) must be replaced with SQL 2005 or 2008 in order to work with 9.0. FlexiCapture 9.0 has SQL Express 2005 delivered as part 
of the distribution kit.

 
Users and Groups
Since ABBYY has switched to a new security model in FlexiCapture 9.0, the user permissions must be set up from scratch in 9.0. FlexiCapture 
9.0 introduces Windows Authentication. User permissions are set up in the Administration and Monitoring Console.

The information about user’s rights can be found in the FlexiCapture 9.0 Help File, (“Granting access rights to users”).

Administration and
Monitoring Console Scanning Stations

Project
Setup Station

Setup and Monitoring IMPORT EXPORTVERIFICATIONRECOGNITION

Data Verification
Stations

Verification
Stations

Database Server Application Server Processing Server Processing Stations

Database

File

CRM

ERP

DMS

ECM

Distributed
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Batch Types
Batch types are not imported from FormReader 6.5. Due to the new structure of batch types in FlexiCapture 9.0, the user must re-create 
batch types using the new settings.

The only information which is imported from batch types is a template structure (in case it is not a custom structure - see Documents and 
batches structure).

Batch types can be created using the Project Setup Station. Information about Batch Types can be found in the FlexiCapture Help File, 
(“Batch types” and “Project Setup Station”).

Using FormReader 6.5 projects in FlexiCapture 9.0

In FlexiCapture 9.0, the structure of projects is different, so the FormReader 6.5 projects cannot be used as is. In order to use your templates and 
flexible descriptions created in FormReader 6.5, please read the instructions below and take all possible issues and limitations into consideration.

Using FlexiCapture Studio 1.5 projects (*.fsp) in FlexiLayout Studio 9.0.
FlexiCapture Studio 1.5 projects can be used in FlexiLayout Studio 9.0. Please note the following:

• �Once the project is opened in FlexiLayout Studio 9.0, it is permanently converted into FlexiLayout Studio 9.0 format and can no longer be 
opened in FlexiCapture Studio 1.5 after this point. Please make sure you create a backup copy of all projects for FlexiCapture Studio 1.5 
before opening them in FlexiLayout Studio 9.0.  This is a safety measure useful in the event you still need to open the projects in FlexiCapture 
Studio 1.5.

• �After opening a FlexiCapture Studio 1.5 project in FlexiLayout Studio 9.0, you need to delete all processing results and analyze all pages once 
again in order to finish converting the project.

Due to the changes in FlexiLayout language, some errors may occur during conversion. In this case, you will need to correct errors and re-
compile FlexiLayouts. Please contact our support team if you need assistance. See Errors which may occur while converting FlexiLayouts.

Using FlexiLayouts (*.afl) created in FlexiCapture Studio 1.5 in FlexiCapture 9.0.
There are numerous changes in FlexiLayout Studio 9.0 compared with FlexiCapture Studio 1.5. That is why we recommend opening a *.fsp 
project in FlexiLayout Studio 9.0 first to check that there are no errors, and re-compile it, even though FlexiLayouts compiled in FlexiCapture 
Studio 1.5 can be loaded into FlexiCapture 9.0. See Errors which may occur while converting FlexiLayouts.

Importing templates from FormReader 6.5 batches (*.frm) 
All FormReader 6.5 templates can be imported to FlexiCapture 9.0. You must specify from which FormReader 6.5 batches (.frm) you want 
to import templates. Conversion will be performed during import.

Note: Batches created in versions earlier than 6.5 cannot be imported. 
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Conversion scenario

1.	Open the FlexiCapture 9.0 Project Setup Station for Distributed installation or the Administrator Station for Standalone installation. 

2.	Create a new project (File > New Project…).

3.	Open the Document Definitions window (Project > Document Definitions…)

4.	Click Import…, then select FormReader 6.5 Batches (*.frm) from the Files of type: list and browse the FormReader batch from 
which you want to import templates.

After you click Open, the import will start. When the import is finished, you will see a window about the import result with a path to 
the log file. 

The log file contains information about conversion including description of warnings or errors, if there are any.

5.	The imported template(s) will appear in the list of Document Definitions. Open them and check field marking, data types and 
validation rules. Both fixed and flexible layouts with fields and their names are imported completely (except additional fields). All data 
types are imported as Custom data types of the document definition. Some of the validation rules are converted automatically; the 
others have to be recreated manually. The information about rules’ conversion can be found in the Compatibility with FormReader 
6.5 validation rules  table below. Tips for converting rules that cannot be imported automatically can be found in the Help File 
(“Migrating from FormReader 6.5 rules and export to FlexiCapture 9.0 scripts”).

6.	Export settings are not converted, so you will need to readjust them.
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7.	Test the imported Document Definition on the test batches. The images from 6.5 batches are not imported; you can add them using 
the File > Load Images… command.

8.	Publish the converted Document Definitions.

Document and Batch Structure   

If the document definition imported from FormReader 6.5 contains a custom structure which is not supported in FlexiCapture 9.0, a set of 
one-paged document definitions will be imported.

1.	Document templates with predefined structure (one-page documents, multi-page documents, sequence of pages) are correctly 
converted into the document definitions for FlexiCapture 9.0 with the same structure.

2.	Custom document structure is not supported in FlexiCapture 9.0. Templates with custom structure will be converted into separate 
one-page document definitions.

3.	If the structure of a batch (custom sequence of documents) was defined in FormReader 6.5, it will be ignored and the batch will be 
considered an arbitrary sequence of documents.

Compatibility with FormReader 6.5 Validation Rules  

Support of FormReader 6.5 validation rules in FlexiCapture 9.0:

FormReader 6.5 Equivalent in FlexiCapture 9.0 Converted automatically

Check against a database “Database Check” rule. No

Check sums “Check Sum” rule. No

Merge blocks “Merge Fields” rule. Yes

Search in the list of suggestions
Field properties, “Data Type” tab. List the 
variants of allowed values in the “Validation” 
field. 

Yes

Replace values from the list

Field properties, “Data Type” tab. “AutoCorrect 
options” field. 

Note. This rule will be converted if we find the 
value and write the result to the same field. 
If the fields are different, the rule cannot be 
converted, and the “Script” rule should be 
used.

Yes

Replace characters from the list

Field properties, “Data Type” tab. “AutoCorrect 
options” field.

Note. This rule will be converted if we find the 
value and write the result to the same field. 
If the fields are different, the rule cannot be 
converted, the “Script” rule should be used.

Yes

Normalize and check dates

Field properties, “Data Type” tab. In the 
“Content” list, select “Date”; in the “Content 
Details” dialog box, select the required 
formats; in the “Validation” field, enter the 
required constraints.

No
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FormReader 6.5 Equivalent in FlexiCapture 9.0 Converted automatically

Regular expressions

Field properties, “Data Type” tab. From the 
“Content” list, choose “Text” or select the 
“Process value as text” option for another 
content type. Enter the required regular 
expression in the “Validation” field.

Yes

Match blocks Can be implemented via a “Script” rule (see 
“Field match check” sample in Help). No

If-Then rules Can be implemented via a “Script” rule (see 
Help for instructions on how to migrate). No

Automation check

Can be implemented via a “Script” rule  (see 
Help for instructions on how to migrate).

If the logic of the rule is too complex and 
requires an external component to be used, 
the component should be called from within 
the code of a “Script” rule (see “Automation 
rule” sample in Help).

No

VBScript rules Can be implemented via a “Script” rule. No

Sum in digits - sum in writing “Sum in digits - sum in words” rule (for 
Russian language). No

Normalize prices

Not supported; can be implemented through 
an external COM component called from a 
“Script” rule.

Price in digits - price in writing No

Validate passport series and number

 
The information about FlexiCapture 9.0 rules can be found in the “Rule validation” section of the FlexiCapture Help File. For more 
information on the “Script” rule, see the “Using scripts in FlexiCapture 9.0” section.

Template conversion issues and possible workarounds

If validation rules and batch or document structures used in FormReader 6.5 have no analogs in FlexiCapture 9.0 and should be re-
created manually, possible issues and workarounds are listed in the tables below. 

Problem Comment Workaround
An error occurred during import: 
 
Import failed: 
Error: Internal Program Error: 
.\Import\Form65XmlBatchSettingsImporter.
cpp, 2756.

The problem is expected to be fixed in the 
maintenance release. 

Until the bug is fixed, the user can delete 
additional fields from the template, like 
functions, manual entry fields, fields to 
be filled with a rule, and then import a 
template.
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Problem Comment Workaround
An error occurred during import:

Import failed. 
Error: Unable to define fixed layout inside 
flexible.

This bug occurs when a field is absent in an 
original FlexiLayout, but the compiled layout 
contained it.

Open the *.fsp project in FlexiLayout Studio 
9.0 first to check that there are no errors, 
and re-compile (match and recognize) it.

An image doesn’t match the converted fixed 
Document Definition, although the same 
images matched the template previously 
conversion.

This happens due to significant changes in 
technologies.

Open the converted Document Definition 
in FlexiCapture 9.0, delete anchors, 
separators and static text, and re-create 
them automatically or manually.

Some rules which must be converted 
automatically (see the table) are not 
converted.

In FormReader 6.5, it was possible to 
create several rules which changed the 
value of the same field. This isn’t possible 
in FlexiCapture 9.0.

Check if you really need such a complicated 
structure. Maybe the problem can be 
solved using the standard FlexiCapture 9.0 
features. If not, use the “Script” rule.

In FormReader 6.5 Enterprise Edition, 
multi-page documents were processed 
successfully. Now after conversion, several 
single-page Document Definitions were 
created instead of a multi-page Document 
Definition.

FlexiCapture 9.0 does not support 
conversion of Custom structures of 
documents. If Custom structure was used 
in FormReader 6.5 Enterprise Edition, 
one-page templates will be imported. See 
Documents and batches structure.

The documents structure is described in 
the FRE6BatchDefinition.sql file. If this file 
was damaged or deleted, only one-page 
templates will be exported.

Check if the FRE6BatchDefinition.sql file 
wasn’t damaged or deleted.

Adjust the document structure to fit 
FlexiCapture 9.0.

There were annexes in the documents, but 
they are not enabled in FlexiCapture 9.0 
Document Definitions after conversion.

In FormReader 6.5, it was possible to add 
annexes using custom structure. Custom 
structure is not converted in 9.0. See 
Documents and batches structure.

Enable annex pages manually in the 
Document Definition Properties dialog 
box, Assembly tab. 

The rules are converted, new rules are 
created but the order of rule execution differs 
from that in FormReader 6.5.

In FlexiCapture 9.0 the order of rule 
execution doesn’t depend on the user’s 
specification, it depends on the document 
structure.

Try to re-create rules in such a way that 
they won’t depend on the execution order.

If the order is very important, try to create a 
“Script” rule which covers all your rules. 

FlexiLayout couldn’t be compiled.
There are numerous changes in FlexiLayout 
Studio 9.0 compared to FlexiCapture Studio 
1.5. 

Open the *.fsp project in FlexiLayout Studio 
9.0, correct errors and re-compile it (match 
and recognize).

If there are errors, you will see invalid 
elements with error descriptions on the 
Errors tab.

Possible errors and workarounds are 
described in the Errors in converted 
FlexiLayouts section.

FlexiLayout has been compiled, but an error 
occurred during matching of this FlexiLayout.

There are numerous changes in FlexiLayout 
Studio 9.0 compared to FlexiCapture Studio 
1.5.

Open the *.fsp project in FlexiLayout Studio 
9.0, correct the code and re-compile it 
(match and recognize).

Possible errors and workarounds are 
described in the Errors in converted 
FlexiLayouts section.
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Errors which may occur while converting FlexiLayouts

Sometimes, the converted FlexiLayout cannot be compiled (matched and recognized). If the FlexiLayout cannot be compiled, you will see 
the corresponding message during templates conversion. Open the *.fsp project in FlexiLayout Studio 9.0. Some of the elements may be 
invalid and have an error description on the Errors tab. It is also possible that the FlexiLayout is successfully compiled, but some errors 
occurred during matching. If you have such problems after conversion, please check if it happened due to one of the errors described 
below.

Please note that some elements may be found in a different way now and the logic of FlexiLayout may change slightly. Test all 
FlexiLayouts on the images before using them for recognition. 

If you need further assistance please contact ABBYY Technical Support at: var_support@abbyyusa.com. 

Problem Comment Workaround

A FlexiLayout will not be compiled with the following errors:

The name of an element coincides with a 
function’s name that didn’t exist in previous 
versions. 

Example: in version 1.5 (and 8.0) it was 
possible to create a text element with a name 
“RSA” and reference it using the short name: 
RSA.IsNull. This code cannot be compiled in 
9.0.

If the element’s name coincides with a 
function’s name, it will be considered as a 
function’s name in the code. It’s possible 
to create an element with the name 
PageNumber, but it is prohibited to write 
PageNumber.IsNull (the only possible way is 
to write SearchElements.PageNumber.IsNull 
);

Use the full name of an element.

Example: 
SearchElements.RSA.IsNull 

If the element had a name which was allowed 
in 1.5 (or 8.0) but prohibited in 9.0, and there 
was a reference to this element using a short 
name in the AdvancedCode, this element will 
be re-named during conversion, but the short 
name in the AdvancedCode is not changed. 
So, in advanced code, there will be a reference 
to the element which doesn’t exist.

In AdvancedCode, the element should be 
re-named manually. 

The following structure is not allowed in 9.0:

Let e = SearchElements.StaticText1; 
e = SearchElements.StaticText2;

As the elements now have user-defined 
properties, the elements of the same type are 
not considered identical.

Change the mentioned structure as 
follows:

Hypothesis e;

e = SearchElements.StaticText1; 
e = SearchElements.StaticText2;

Incorrect usage of elements’ short names.

Example:

There are elements: SearchElements.A.A, 
SearchElements.A.B, SearchElements.A.C.

In previous versions, it was possible to use 
the following structure in the code of element 
C: A.B

In 9.0, such a structure cannot be compiled. 
A is considered  SearchElements.A.A, but this 
element hasn’t a B field.

A conflict may arise when short names are 
used. In 1.5 (and 8.0), in case of conflict, the 
high-level element was selected. In 9.0, the 
low-level element is selected.

Use the full names of elements.
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Problem Comment Workaround
The following errors may occur during layout matching:

Error at position -1: Text for search not 
defined.

In 1.5, it was allowed to search a text which 
consisted of a space only. In 8.0 and 9.0, it 
isn’t allowed.

Use allowed text for searching.

Error in element “SearchElements.StaticText”, 
Pre-search relations section: D:\Tests\
ForConversion\1.txt was not found.

In FlexiCapture 9.0, a reference folder for 
relative paths to the text files used in the 
StaticText element was changed. In 1.5 (and 
8.0), the relative path began from the batch’s 
folder (where the images are stored). In 9.0, 
they begin from the project’s folder (the folder 
which contains the .fsp file).

Place the mentioned text file to the 
folder indicated in the message (for 
this example, you should put the file 
“1.txt” to the following folder: D:\Tests\
ForConversion\). You can also change the 
path to the file.

ABBYY USA
880 North McCarthy Blvd., 
Suite #220
Milpitas, CA 95035, USA

©2009 ABBYY USA Software House, Inc. All rights reserved. ©1987-2003 Adobe Systems Incorporated. Adobe PDF Library is licensed from Adobe Systems Incorporated. ABBYY, the ABBYY logo and FlexiCapture are registered trademarks of ABBYY Software Ltd. Adobe, the Adobe logo, the Adobe PDF 
logo and Adobe PDF Library are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Microsoft, Excel, Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries. Fonts Newton, Pragmatica, 
Courier ©2001 ParaType, Inc. Font OCR-v-GOST ©2003 ParaType, Inc. All other trademarks are the property of their respective owners. Information contained in this document is subject to change without notice.

Tel  +1 866.463.7689
Fax +1 408.457.9778 
sales@abbyyusa.com www.ABBYYUSA.com


